Max External Tutorial (v. 2.2) Fujinaga
Version 2.2 (March, 1999) by Ichiro Fujinaga

This document is atutorial for writing external objects for Max 3.5.x. It assumes that

the reader is familiar with the Max environment and the C Programming Language.

This document is intended to expand upon the material presented by David Zicarelli

in his Writing External Objects for Max (1996) and is based on atutorial started by

Dale Stamman while at McGill University. It is strongly recommended that the

reader study both documents before attempting to create an external Max object.

Several examples are provided to demonstrate this process. Max externals (external

objects) can be created using Think C, Symantec C++, and CodeWarrier.

Thisversion (2.0) describes the development of Max externals (PowerPC only)

using CodeWarior on PowerPC. If you are using Think C or Symantec C++

compilers or on 68k machines please refer to the version 1 of this document.
Developing Max External Object with CodeWarrior

Thistutorial will explain how to create PowerPC native Max externals using

MetroWerks Codewarrior (Pro 2 or later) Refer also to Zicareli (1996, 12-8). A very

simple external object called bang will be created. Refer to Figure 1. for the source

code of bang.c. The explanation of how bang works and writing Max external
objectsis provided later. First, some preparations arein order.
Creating a PPC Max External Object (shared library) with CodeWarrior Pro

1. Make sure both Max 3.5.x with Software Develpers Kit and CodeWarrior are
properly installed.

2. Launch CodeWarrior IDE.

3.  Select New Project... from the File menu.

4. Inthediaog box (Select project stationary), usethe MacOS:C_C++:
Standard Console:Std C Console PPC. Name the new project, e.g., bang.p
(option-M). A Project window named bang.u should open.

5. Removethe ANSI Libraries folder in the project window by clicking on the
name then select Remove Selected Items in the Project menu.

6. Removethe Sources folder in the project window by clicking on the name
then select Remove Selected Items in the Project menu.

7.  Select New from the File menu. Enter the C source code into this window or
copy asourcefile (bang.c) into the folder then drag-and-drop the file into the
Project window.

8. Select Add Files... from the Project menu to add MaxLib, which can be found
in Max::Software Development Kit::Max #includes, to the project. (Close
the Access Path message box.) If you are writing M SP externals, you will
also need to add SoundLib and Max Audio Library.

9. Select PPC Std C Console Settings... from the Edit menu. Select PPC
Target from the Target Settings Panels. Change the Project Type from
Application to Shared Library, Change the File Name to name of the object,
e.g., bang, Creator to max2, and File Type to ???7.
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10. Select PPC Linker from the Target Settings Panels. Uncheck Generate
SYM File. Type main in Main: under EntryPoints.

11. Select PPC PEF from the Target Settings Panels. Check Expand
Uninitialized Data. Close the PPC Std C Console Settings window and
saveit.

12. To compilethe code, select Make from the Project menu.

13. Run Max on a PPC Mac. Create a new patcher and create a new box. Type the
object name into the box and external object will be created. The location of the
object should be specified in the File Preferences... in the Options menu of
Max.

[see also Zicarelli (1996, 12-4)]

Fujinaga

/'l bang.c -- A very sinple Max external object.

11 Qut puts a bang when a bang is received.

11 97/03/08 | F

11 98/ 01/ 13 | F CodeWarrior/PPC only version

#i nclude "ext.h" /! Required for all Max external objects

voi d *this_class; /1 Required. dobal pointing to this class

typedef struct bang // Data structure for this object
bj ect b_ob; /1l Must always be the first field; used by Max
void *b_out; /1 Pointer to outlet. need one for each outl et

} Bang;

/1 Prototypes for nethods: need a nethod for each inconm ng nessage

voi d *bang_new(voi d); /'l object creation nethod

voi d bang_bang(Bang *bang); /1 nmethod for bang message

voi d mai n(voi d)

/'l set up our class: create a class definition
setup(& his_class, (method) bang_new, OL, (short)sizeof(Bang), OL, 0);

addbang( (et hod) bang_bang); // bind nmethod "bang_bang" to the "bang" nessage

voi d *bang_new( voi d)
Bang *bang;

/] create the new instance and return a pointer to it
bang = (Bang *)newobj ect (this_cl ass);

bang->b_out = bangout (bang); /1l create a bang outl et

ret urn(bang); /1 must return a pointer to the new instance

voi d bang_bang(Bang *bang)
outl et _bang(bang->b_out); // sinply bang!

Figure 1. Source code for bang.c
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Writing Max External Objects

Fujinaga

To create an external Max object, you write a code resource (68k) or a shared library
(PPC). When you type the name of your object into an empty box in a Max patcher
window, its code resource file is opened and its contents loaded into memory. The
object isthen created and able to receive messages from the Max environment. How
your object will respond to the various messages is determined by the code you have
written.

Y our code for an external Max object will consist of a main function and functions
(methods) that respond to specific Max messages sent to your object by the Max
environment.

The sturcture of aminimal external object can be divided into four sections:
* intiaization\
e main()
»  definition of the method to create a new object
o definition of methods that bind to other messages

Theintializations consists of the necessary #include files, object structure definition,
global variable declarations, and function prototypes. The main function, which is
called only once when the user types the name of your object into abox in aMax
patcher window for the first time, will define your objects classviaset up()
function and binds methods that will be used for incoming messges. The only
requisite method for any class definition is the method that creates new objects.
Within this method, memory for the new object is allocated and inlets and outlets are
defined. Finally, methods that respond to other messages and other functions are
defined. An explantion of each of these four sections are given below using avery
simple object called bang, which simply outputs a bang upon a bang input. (See
Figure 1 for the complete source code.)

The bang object: Initialization

The following lines are required for all objects:

#i nclude "ext.h" /1l Required for all Max external objects
void *this_class; /'l Required. dobal pointing to this class

The next step is to define a data structure for the bang Max object. This structure
must start with afield called an Object. The Object contains references to the bang
object’s class definition as well as some other information. It is used by Max to
communicate with the bang object. The following is the data structure for the bang

object:
typedef struct bang /] Data structure for this object
{
Obj ect b_ob; /1 Must always be the first field; used by Max
void *b_out; /1 Pointer to an outlet

} Bang;

It isaMax convention to start the names of each field in the data structure with a
lower case |etter followed by an underscore (e.g. b_out).

After the object’ s data structure has been declared, the class methods that will
respond to Max messages need to be declared. Y our object will do its work by
responding to messages from the Max environment. Objects commonly receive
integer and float messagesin their inlets. Y our object’ s methods will process these
numbers in some way and then send out messages using the object’ s outlets.
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Y our code must include methods (functions) that can respond to each message your
Max object will receive. The bang object will receive a“new” message when
someone types its name into abox in aMax patcher window. Therefore it is
necessary to provide a method that will handle this message and create a new
instance of the bang object. The bang object is aso expected to sent out a“bang”
message on the outlet, upon areceipt of a“bang” in the left inlet. Methods will have
to be written to handl e this message. The declaration (prototypr) of these methods is
shown below.

/1 Prototypes for methods: need a nethod for each incom ng nessage
voi d *bang_new(voi d); /] object creation nethod
voi d bang_bang(Bang *d); /1 method for bang nessage

The bang object: main()

Fujinaga

voi d mai n(voi d)

When your object is created by Max for the first time, Max will load your code
resource into memory and create the first instance of your class. At thistime, Max
will call your code resource’ s main function once and only once. The main function
specifies how your object should beinitialized. The main function needsto do the
following:

1.  Setupyour class: alocate memory for the object and specify methods for the
creation of instances of your object.

2. Define messages that the object can respond to and bind each message to a
method.

Hereisthemai n() function of the bang object:

/1 main receives a copy of the Max function macros table

/] set up our class: create a class definition
setup((& his_class, (nmethod) bang_new, OL, (short)sizeof(Bang), OL, 0);

addbang( (et hod) bang_bang); // bind nethod "bang_bang" to the "bang" nessage

March 8, 1999

The setup function creates a definition of the bang object class, which will be used
by thebang_new method to create new instances of thebang object. In the above
call to the setup function for the bang object, t hi s_cl ass isthe global variable
declared at the beginning of the code. The second argument, bang_new, isa
pointer to the instance creation method bang_new. Thisisthe method that will be
called when the object receives a“new” message from the Max environment. Since
the bang object does not require any special memory cleanup when it is removed
from the Max environment, OL isused in place of apointer toabang_free
method. The memory occupied by the bang object and all of itsinlets and outlets
will be removed automatically by Max.

The next argument to setup allocates memory for the class. In this example,

si zeof (Bang) isused to determine the number of bytes of memory needed.
Since we are not creating a user interface object, the next argument to menufun will
be OL. The final O indicates that there is no argument to this object.

As mentioned above, the code must provide a method for each message you want to
respond to. In the main function, each method should respond to the message with
thefunctions: addi nt, addi nx, addbang, addnmess, oraddft. Since
the bang object only responds to the “bang” message, only one method,

bang_bang, isneeded. Inorder to bind the bang_bang method, which will output

a“bang”, to a“bang” input message, we use the routine addbang( bang_bang) .
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The bang object: The object creation function

When a user creates a new instance of your object by typing the name bang into a
box in aMax patcher window, opening afile with your object already in it, or by
cutting and pasting your object, your object will receive a“new” message. Thisisa
request to your creation method to create an object that is an instance of your class.
The creation function then handles any arguments that were typed in the box in the
Max patcher window, initializes data fields, and creates the object’ sinlets and
outlets. Finally, the creation function returns a pointer to the new instance of the
object. These actions are shown in the method bang_new listed below.

voi d *bang_new(voi d)
{
Bang *bang;

// create the new instance and return a pointer to it
bang = (Bang *)newobj ect (this_cl ass);

bang->b_out = bangout (bang);// create a bang outl et

return(bang); /1 must return a pointer to the new instance

The function, newobj ect , isusedto create a new instance of the class bang. The
argument, t hi s_cl ass, istheglobal variable that pointsto this class. This
pointer was set by the setup function in the main function.

When your object is created, Max automatically creates one inlet, but other inlets and
outlets must be explicitly defined. Using the bangout function, an outlet (that only
outputs “bang” messages) will be created and returns a pointer, which will be stored
in the object’sdatafield b_out .

Finally, bang, the pointer to the new instance of our object that was returned by
the call to newobj ect, must be returned from the function bang_new.

Now we have a new instance of our object represented as a“bang” box in a Max
patcher window. It is now waiting to receive “bang” messages that will cause its
method to do the specified operation, namely, ouput a“bang”. We will now examine
how thisis done.

The bang object: Handling the “bang” message

voi d bang_bang(Bang *bang)
out | et _bang(bang->b_out); /'l sinply bang!

When a“bang” message arrives at the object’ s left inlet, the bang_bang function
(method) is called. This happens, because in the mai n() the“bang” messge, was
bound to this function bang_bang() by the function:

addbang( METHOD bang_bang) ;

Thebang_bang method simply sends a“bang” messages viathe outlet. The
method calls the Max function out | et _bang to cause the “bang” to be output. In
the object creation function, bang_new (see above), an outlet was created for this
object with the statement:

bang- >b_out = bangout (bang).

This function returned a pointer to the object’ s outlet which we stored in the struct
fieldbang- >b_out .
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The add object: Inlets and arguments

Fujinaga

A simple object add will be used to introduce how to add inlets and arguments to
your object. This object basically functions as the Max built-in “+” object. It ouputs
the sum of two integers: the number coming in on the left inlet plus the number
stored in the object which can be either specified viatheright inlet or in the
argument inside the object’ s box. The source code is shown in Figure 2.

/* add.c -- 97/03/24 |F (based on Dale Stamen's diff)

* % 98/ 01/ 14 for Power PC only

**  This code resource defines an object sinmlar to the standard "+" nax object.

**  The add object has 2 inlets and 1 outlet. Left inlet accepts bang and integers,
** right inlet accepts integers, and outlet outputs the adderence of the 2 inputs.
*/

#i ncl ude "ext.h" /! Required for all Max external objects
typedef struct add // Data structure for this object
{

hj ect a_ob;
long a_valleft;
long a_valright;
long a_valtotal;
void *a_out;

} Add;

Must al ways be the first field; used by Max
Last value fromleft outlet

Last value fromright outlet

Val ue to be sent to outlet

Pointer to outlet, need one for each outlet

—~———— —
—~———— —

/1 Prototypes for methods: you need a nethod for each nessage you want to respond to
voi d *add_new(| ong val ue); /1 Qoject creation nethod
voi d *add_i nt (Add *add, |long value); // Method for nessage "int" in
voi d *add_i n1(Add *add, long value); // Method for nessage "int" in
voi d *add_bang( Add *add); /1 Method for bang nessage
voi d *add_assi st (Add *add, Object *b, long nmsg, long arg, char *s); // Assistance nethod

left inlet
right inlet

voi d mai n(voi d) /1 main receives a copy of the Max function macros table

{
/] set up our class: create a class definition
setup( & his_class, (method)add_new, OL, (short) sizeof (Add), OL, A DEFLONG O0);

addbang( (et hod) add_bang); // bind nethod "add_bang" to the "bang" nessage

addi nt ((net hod) add_i nt) ; /1 bind method "add_int" to int's received in the left
inlet

addi nx((nmethod)add_in1,1); // bind nethod "add_inl" to int's received in the right
inlet

AR AR E R E R EEEEEEEEEEEEEEEEEREEEEEEEEEEEEEREE R EEEEEEEEEEEEEEEEEEEEEEEEEE LR

add_new( | ong val ue)

i nput s: value -- the integer fromthe typed argunent in the object box
description: creates a new instance of our class add. Called once when the code
resource is | oaded.

returns: pointer to new instance
KK KKK I KK IR KKK KKK IR KKK KKK IR K I KK KRR IR KKK KKK I A KRR KRR KKK K KKK KK AR KRR KK IR KKKk k kK [

voi d *add_new(| ong val ue)

Add *add;

add = (Add *)newobj ect (this_class); /]l Create new instance and return a pointer to
it

add->a_val ri ght = val ue; /1 Initialize the addition value

add->a_valleft = 0;

add->a_valtotal = val ue;

add->a_out = intout(add); /1l Create our outlet
March 8, 1999 6
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intin(add, 1); /1l Create the right inlet

return(add); /1 Must return a pointer to the new instance

AR E R E R EEEEEEEEEEEEEEEEEREEEEEEEEEEEEEREE R EEEEEEEEEEEEEEEEEEEEEEEEE LR

add_i nt (Add *a, |ong val ue)

i nput s: add - pointer to Add object
val ue - value received in the inlet
description: adds the right value with the incom ng value. Stores the new left inlet
value as well as the total and outputs the total
returns: not hi ng

LEE AR EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEREEEREEEEEEEEEEEEEEEEEEEEEEEEEEEEREEEEEEEERELY]

voi d *add_i nt (Add *add, |ong val ue)

add->a_valleft = value; // Store the value received in the left inlet

add->a _valtotal = add->a_valleft + add->a_valright; // Add the right inlet value with
the |eft
add_bang(add); /1 Call bang nethod right away since it's the left inlet

AR R R R EEEEEEEEEEELEEEEEAEEEEEEEEEEEEEEEEEEEEEEEEEEREEEEEEEEEEEEEEEEEEEEEEEE]

add_i n1( Add *add, |ong val ue)

i nput s: add - pointer to our object
val ue - value received in the inlet
description: stores the new right value, calculates and stores the new adderence between
the left and right val ue

returns: not hi ng
*************************************************************************************/

voi d *add_i n1( Add *add, | ong val ue)
{

add->a_val ri ght = val ue; /1 Store the val ue

add->a_valtotal = add->a_valleft + value; // Update new tota

R R R K K kR K Kk K KRR Kk R K KR R Kk R K K R R Rk R KR R Rk R KR R Rk KR R R R R KR R R R R R R R R R R R R R R R R R Rk ok kK K

add_bang( Add *a)

i nput s: add - pointer to our object
description: nmethod called when bang is received: it outputs the current sumof the |left
and right val ues

returns: not hi ng
*************************************************************************************/

voi d *add_bang( Add *add)

outlet_int(add->a_out, add->a_valtotal); // sinply put out the current tota

Figure 2. Source code for the add object
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The add object: Initialization

The data structure for the add object is shown below. Note that three values are
stored within the object.

typedef struct add // Data structure for this object
{

hj ect a_ob;
long a_valleft;
long a_val right;
long a_valtotal;
voi d *a_out;

} Add;

Must al ways be the first field; used by Max
Last value sent to left outlet

Last value sent to right outlet

Val ue to be sent to outlet

Pointer to outlet, need one for each outlet

—~——— —
—~——— —

Intheset up functionin mai n() now has A_DEFLONG argument indicating that
the object accept one integer argument in the object box.

setup(& his_class, add_new, OL, (short)sizeof(Add), OL, A DEFLONG O0);

Three methods are bound with the three typs of messages. “bang” in the left inlet,
interger entered in the left inlet, and integer entered in the right inlet.

addbang( ( et hod) add_bang) ; /1 bind "add_bang" to the "bang" nessage
addi nt ((net hod) add_i nt); // bind "add_int" to int received in the left inlet
addi nx( (net hod)add_i n1, 1); /! bind "add_inl" to int received in the right inlet

The add object: The object creation function

Unlike the bang object above, theadd_newfunction is passed an integer argument
from the object box that the user may type. The object’ s variables are initialized, an
outlet that output intger is created and the right inlet, which accepts integer is also
Created:

voi d *add_new(| ong val ue)
Add *add;

add = (Add *)newobject(this_class); // Create new instance and return a pointer to it

add->a_val ri ght = val ue; // Initialize the add val ues

add->a_valleft = 0;

add->a_valtotal = val ue;

add- >a_out = intout(add); /1 Create our outlet

intin(add,1); Il Create the right inlet

return(add); /1 Must return a pointer to the new instance

The add object: Methods

Theadd_i nt method is called when an integer comesin on the left inlet. It stores
thevalueina_val | ef t , addsthat valuewitha_val ri ght , storing theresult in
a_val tot al , thencallstheadd_bang method to ouput the result.

voi d *add_i nt (Add *add, |ong val ue)

add->a_val l eft = val ue; /1 Store the value received in the left inlet
add->a_valtotal = add->a_valleft + add->a_valright; // Add the right inlet value with
the left
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add_bang(add) ; /1 Call bang nethod right away since it's the left inlet

Theadd_i n1 method is called when an integer comesin on theright inlet. It stores
thenew valueina_val ri ght thenupdatestheval total .

void *add_i n1( Add *add, | ong val ue)
add- >a_val ri ght = val ue; /Il Store the val ue
= /1

add->a_val total add->a_val l eft + val ue; Updat e new t ot al

Theadd_bang method is called when a“bang” comesin theleft inlet or, indirectly
viaadd_i nt method, when an integer comesin the left inlet.

voi d *add_bang(Add *add)

outlet_int(add->a_out, add->a_valtotal); // sinmply put out the current total

The add_assist object: Adding to the Max’s New Object list and assistance messages

Two enhancements will be added to the add object: the object (add_assist) will be
included in the Patcher’s New Obiject list and the assistance messages, which
appears when the mouse is pointed at object’ sinlets and outlets. The complete listing
of add_assist object isin Figure 3.

To make an entry in the New Object list isvery simple. All you need to doisto
include the following function in your mai n() :

finder_addcl ass("All Objects", "add_assist"); // add class to the New object |ist
If you want to add the object to the "Arithmetic/ Logic" list, you could add the
following:

finder_addcl ass("Arithmetic/Logic", "add_assist");

In order to add the assistance messages: a method must be defined, which must be
bound to the Max message “assist”, and since we will be using a resource for the
string for the assi stance messages, we need to copy the string from the resource. The
binding and the copying is doneinthemai n() asfollows:

addness((net hod) add_assi st, "assist", A _CANT, 0); /1 bind method add_assist to the
/| assi stance nessage

rescopy(' STR#', ResourcelD); // copy the assistance nessages resource into Max's tenp
file

Resourcel D is a number that you define when creating the string resource. The

r escopy function copiesthe string to Max’ s temporary file (Max Temp 1 inthe
Temporary Items folder). How to create this resource is explained next. The
explanation of theadd_assi st method will follow.
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Creating a String Resource in ResEdit 2.1 for a Max External Object

Fujinaga

Launch ResEdit.
Click on the clown to get rid of it.
Select New... from the File menu; move to your project folder.

Name your resource file with EXACTLY the same name as your project and
append the name with .rsrc. For example, if your project is called
projectname.j, name your resource projectname.pLrsrc.

Click the New button
6. Select Create New Resource from the Resource menu.

7. Scroll down to the resource type STR# in the Select New Type window.
Make sure you select STR# and not STR. Click on OK.

8.  ResEdit will now create awindow called STR# ID = 128. Click on thefield 1)
*rxxx Select Insert New Field(s) from the Resource menu. In the box after
The string, typein your external Max object's assistance string for the first
inlet. You may use a maximum of 60 characters. Repeat step 8 for as many
inlets and outlets as your Max object will need. Create them in order, with the
first string being the message for inlet 1, the second for inlet 2.

9. Select Get Resource Info from the Resource menu. Enter your resource ID
number in the field ID:. This number MUST match the resource ID number you
definein your Max object. If you wish, you may type in the name of your
resourcein the field Name. Thiswill help you remember what the resource is
used for in the “resource picker window”.

10. Saveyour resource. Make sureit is saved to your project folder and that it has
the same name as your project file with .rsrc added to the end of the name.

A w DN

o

The add_assist object: add_assi st method

voi d *add_assi st (Add *add, Object *b, long msg, long arg, char *s)
{

Ent er Cal | back();

/] copy the appropriate message to the destination string
assi st_string(ResourcelD, nsg, arg, 1, 3, s);
Exi t Cal | back();

March 8, 1999

In the argument list for add_assist, d is a pointer to our object, b is a pointer to the
object’s box in the Max patcher window. msg will be one of two vaues: 1 if the
cursor isover aninlet or 2 if it isover an outlet. arg istheinlet or outlet number
starting at O for the left inlet. siswhere you will copy a C string containing your
assistance information.

The function assist_string handles the posting of the assistance string in the
assistance area of the Max patcher window. It will copy the correct string from the
resource in the memory specified by Resourcel D. (Resourcel D was defined at the
beginning of the code.) This resource was copied into the Max’ s temp file by
rescopy( ) inthemai n function. msg specifiesif either aninlet or outlet was
selected and arg isthe inlet or outlets number. The argument 1 specifies that the first
string in the resource corresponds to the first inlet. Likewise, the argument 3
specifies that the third string in the resource goes with the first outlet. The function
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assist_string will copy the selected resource string into s, which will then be
displayed in the assistance area of the patcher window.
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/* add_assist.c -- 97/03/24 |F (based on Dale Stammen's diff)

*x 98/ 01/ 14 for PowerPC only |IF

**  This code resource defines an object simlar to the standard "+" nax object.

**  The add object has 2 inlets and 1 outlet. Left inlet accepts bang and integers,
** rjght inlet accepts integers, and outlet outputs the adderence of the 2 inputs.
*

/

#i ncl ude "ext.h" /! Required for all Max external objects
void *this_class; /! Required. dobal pointing to this class
#define ResourcelD 3999 // resource |ID# for assistance strings created in ResEdit

typedef struct add // Data structure for this object

Obj ect a_ob; /1 Must always be the first field; used by Max

long a_valleft; /1 Last value sent to left outlet

I ong a_valright; // Last value sent to right outlet

long a_valtotal; /1 Value to be sent to outlet

void *a_out; /1 Pointer to outlet, need one for each outlet
} Add;
/1 Prototypes for methods: you need a nethod for each nessage you want to respond to
voi d *add_new(| ong val ue); /1 Onject creation nmethod
void *add_i nt (Add *add, Iong value); // Method for nessage "int" in left inlet
void *add_i n1(Add *add, long value); // Method for message "int" in right inlet
voi d *add_bang( Add *add); /1 Method for bang nessage

voi d *add_assi st (Add *add, Object *b, long nsg, long arg, char *s); // Assistance nethod
voi d nai n(voi d) /1 main receives a copy of the Max function nacros table

/] set up our class: create a class definition
setup(& his_class, (method)add_new, OL, (short) sizeof (Add), OL, A DEFLONG O0);

addbang( ( net hod) add_bang) ;
addi nt ((net hod) add_i nt) ;

addi nx( (net hod) add_i n1, 1) ;

/ bind nethod "add_bang" to the "bang" nessage

/ bind nethod "add_int" to int's received in the

/1 left inlet

/ bind nethod "add_inl" to int's received in the
/1 right inlet

addness( (et hod) add_assi st, "assist", A CANT, 0); /1 bind nethod "add_assist" to

/1 the assistance nessage
rescopy(' STR#', ResourcelD);// copy tfhe assi stance messages resource into Max's
tenp fi
finder_addcl ass("All Objects", "add_assist"); // add class to the New object Iist

\_,,\\

/**********************************************************************************

add_new( | ong val ue)

i nput s: value -- the integer fromthe typed argunent in the object box
description: creates a new instance of our class add

Cal | ed once when the code resource is |oaded.
returns: pointer to new i nstance

LEE RS EEEEEEEEEEREEEEEEREEEEEEEEEEEEEEEEEREEEEEEEEEREEEEEEEEEEEEEEEEEEEEREEEEEEREEERY)

voi d *add_new(| ong val ue)

Add *add;

add = (Add *) newobj ect(this_class); [// Create the new instance
add->a_val ri ght = val ue; ~// Initialize the addition val ue

add->a_val | eft = 0;

add->a_valtotal = val ue;

add->a_out = intout(add); /Il Create our outlet

intin(add, 1); Il Create the right inlet

return(add); /1 Must return a pointer to the new instance

/**********************************************************************************

add_i nt (Add *a, |ong val ue)
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i nput s: add - pointer to Add object
val ue - value received in the inlet

description: adds the right value with the incomng value. Stores the new left inlet
value as well as the total and outputs the total

returns: not hi ng

LEE RS EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEREEEREEEEEEEEEEEEEEEEEEEEEEEEEEREEEEEEEERELY]

voi d *add_i nt (Add *add, |ong val ue)
{

add->a_val l eft = val ue; /1l Store the value received in the left inlet
add->a_val total = add->a valleft + add->a_valright; // Add the right with the left
add_bang(add) ; /1 Call bang nethod right away since it's the left inlet

}

AR R R R EEEEEEEEEEEEEEEEAEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE]

add_i n1( Add *add, |ong val ue)

i nput s: add -- pointer to our object
value -- value received in the inlet

description: stores the new right value, calculates and stores the
new adder ence between the left and right val ue

returns: not hi ng
*************************************************************************************/

voi d *add_i n1( Add *add, | ong val ue)
{

add->a_val ri ght = val ue; /] Store the val ue
add->a_valtotal = add->a_valleft + value; // Update new tota

/*************************************************************************************

add_bang( Add *a)

i nput s: add -- pointer to our object

description: nethod called when bang is received: it outputs the current
sumof the left and right val ues

returns: not hi ng

LR R R R EEEEEEEEREEEEEEEEEEREEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEERY]

voi d *add_bang( Add *add)

outlet_int(add->a_out, add->a_valtotal); // sinply put out the current tota

R R R K K kR K Kk K KRR Kk R K KR R Kk R K K R R Rk R KR R Rk R KR R Rk KR R R R R KR R R R R R R R R R R R R R R R R R Rk ok kK K

voi d *add_assist(a, b, nsg, arg, s)

i nput s: add - pointer to Add object
b - pointer to the Add object's box
nsg - specifies whether request for inlet or outlet info
arg - selected inlet or outlet nunber

S - destination for assistance string

description: nethod called when assist nmessage is received: it outputs the correct
assi stance nessage string to the patcher w ndow

returns: not hi ng

LR R EEEEEEEEREEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEERY]

voi d *add_assi st (Add *add, Object *b, long msg, long arg, char *s)

/] copy the appropriate nmessage to the destination string
assi st_string(ResourcelD, nmsg, arg, 1, 3, s);

Figure 3 Source code for add assist object
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The minimum object: Float, Atom, and list

Thus far, the only data type we have been using is an integer type, namely long. In
this section, we' Il introduce the float data type, the Atom datatype, and the list,
which isan array of Atoms.

Thefloat datatype is similar to long except that it involves floating-point numbers.
Max provides macros and functions to handle floats very similar to longs, e.g., to add
left inlets you would use:

addi nt (1 ong_nret hod) ;

for inlet that accepts long and use:

addf| oat (f| oat _net hod) ;
for inlet that accepts float.

An Atom isaspecial datatype (a structure) that allows any of the four data types
(long, float, Symbol, Object) used in Max to be stored. Here is how it is defined:

uni on word /* union for packing any data type */
| ong w_| ong;
fl oat w_float;

Synbol *w_sym
j ect *w_obj ;

H

typedef struct atom /1 and an atomwhich is a typed datum
short a_type; // fromthe defs bel ow
uni on word a_w,

} Atom

The struct member a_type specifies what type of datais stored in a_w, and it could
be any of the following:

#defi ne A NOTH NG
#define A_LONG
#define A FLOAT

0 ends the type list

1

2
#define A_SYM 3

4

5

/

7

Type- checked i nteger argunent
Type- checked fl oat argument
Type- chceked synbol argunent
for argtype lists; passes the value of sym
long but defaults to zero
/ float, sane default
/'l symbol, defaults to ""

#define A_OBJ

#defi ne A DEFLONG
#defi ne A DEFFLOAT 6
#defi ne A_DEFSYM

~————
~————

A listin Max issimple an array of Atoms. A list will be used if you declare a method
to receiveits arguments with A_GIMME, typically in either the setup function:

setup(&cl ass, (nethod)m ni mumnew, OL, (short)sizeof(Mninmm, OL, A G ME A NOTH NG ;

or amethod that responds to the “list” message:
addness((nethod)mi nimumlist, "list", A G MVE, A NOTH NG ;

Then your method, mi ni mum_| i st in the example above, will be passed alist.
Thisisdone by ar gc (short)and ar gv (At om *) . ar gc isthe number of
Atomsand ar gv pointsto the first Atom in the array. Here is an example:

void mnimumlist(Mninmm*x, Synbol *s, short argc, Atom *argv)

The Symbol *s contains the message itself (in this case, “list”). The object minimum
illustrates use of these data types (see Figure 4).
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*/

/* mnimumc -- output the mnimumof a group of nunbers ------

/1 Fromthe Max 3.5 distribution. Slightly nodified by |F 97/04/02
/1 For PowerPC only 98/01/14 | F

/1 Topics covered: floats, Atonms, lists

#i ncl ude "ext.h"

#def i ne MAXSI ZE 32
#defi ne Resourcel D 3008

typedef struct m ninmum

struct object m ob;
At om m ar gs[ MAXSI ZE] ;
| ong m count;
short m.i ncount;
short mouttype;
void *m out;

} Mninmm

void *cl ass;
voi d DoAt omM n(Atom *min, Atom *new);

voi d m ni mum bang(M ni mum *x) ;

void m ni mum.int (M ni mum *x, Iong n);

void m ni num.inl(M ninum*x, long n);

voi d m'nimlmfloat(Mnlmlm X, doublef);

void mnimum fti(M nimum * x doublef),

void minimmlist(Mninmm*x, Synbol *s, short ac, Atom *av);
voi d m ni mrum assi st(Mnimum *x, void *b, long m long a, char *s);
voi d *m ni mum new Synbol *s, short ac, Atom *av);

void main(fptr *f)

{

setup((&cl ass, (nethod)m ni mumnew, OL, (short)sizeof (M ninmm,
oL, A

G MVE, 0);
addbang( (et hod) mi ni mum bang)
addi nt ( (et hod) mi ni mum.i nt);
addi nx( (et hod) m ni rum.inl, 1);
addf | oat ((net hod) mi ni mum f1l oat);
addftx((nmethod) m nimum ftil, 1);
addmess( (et hod) m ni mum|list, "I i st", A GME 0);
addness( (et hod) m ni mum assi st assi st", A _CANT, 0);
finder addclass( Arith/Logic/ Bitwi se", "mni munt') ;
rescopy(' STR#', ResourcelD);

voi d DoAtonmM n(Atom *nmin, Atom*new) // check to see if new mi ni num
!/ dependi ng on the data types

{
if (mn->a_type==A NOTHING // At startup set m ninum

*mn = *new,
return;

}
if (mn->a_type==A FLOAT) // old is FLOAT
if (new >a_type==A FLOAT) // new is FLOAT

if (new>a_w wfloat < mn->a_w w float)
mn->a_w. w_float = new>a_w w_fl oat;

}
else //newis LONG old is FLOAT
if ((float)new>a w.w.long < mn->a w wfloat)
mn->a w.w float = (float)new >a w. w_|ong;

}
}
else // old is LONG

if (new>a_type==A LONG) // new is LONG
{
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if (new>a_w w_|ong < nmin->a_w. w_| ong)
mn->a_w. w_|ong = new >a_w. w_| ong;

else // newis float, old is LONG

if ((long)new>a_ w. w float < min->a_w. w_|ong)
m n->a_w. w_|ong = (long)new >a_w. w_float;

}
voi d m ni mum _bang(M ni num *x)

regi ster short i;
Atom t hemi n;

I ong res;

doubl e fres;

them n.a_type = A NOTH NG

for (i=0; I < x->mcount; i++) /1 check if any of the input
DoAt omM n( & hem n, x->m args+i ) ;

if (x->mouttype==A LONG

if (themn.a_type==A LONG

res = thenmin.a_w w_| ong;
el se

res = (long)themn.a w w float;
outlet_int(x->mout,res);

el se

if (themn.a_type==A FLOAT)

fres = themn.a_w w float;
el se

fres = (float)them n.a_w. w_| ong;
outlet_float(x->mout,fres);

}
voi d mini mum_int(M nimum *x, |ong n)

SETLONG( x- >m_ ar gs, n) ;
m ni num_bang(x) ;

}
voi d mni mum_inl(M nimum *x, |ong n)

SETLONG( x- >m ar gs+1, n);
X->m.count = 2;

voi d m ni mum fl oat (M ni nrum *x, double f)

SETFLOAT(x->m args, f);
m ni mum_bang(x) ;

}

void mni num ft1(M ninum *x, double f)

SETFLOAT(x->m args+1, f);
X->m.count = 2;

}
void mnimumlist(Mninmum*x, Synbol *s, short ac, Atom *av)
regi ster short i;

if (ac >= MAXSI ZE)
ac = MAXSI ZE - 1;
for (i=0; i < ac; i++, avtt)

if (av->a_type==A LONG

SETLONG( x- >m ar gs+i , av- >a_w. w_| ong) ;
else if (av->a_type==A FLOAT)

SETFLOAT( x->m args+i, av->a_w. w_fl oat);

is a new mni mum
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X->m count = ac;
m ni mum_bang(x) ;

}
voi d m ni nrum assi st(Mnimum *x, void *b, long m long a, char *s)

assist_string(ResourcelD, m a, 1, 3, s);

voi d *m ni mum new Synbol *s, short ac, Atom *av)
M ni num *x;
= (M ni mum *) newobj ect (cl ass);

->m.count = 2;
(ac)

xX X

~——

X->m args[1l] = *av; /1 intialize with the first argunent
if (av->a_type==A LONG
{

x->m args[0].a_type = x->mouttype
X->mout = intout(x);
x->margs[0].a_w. w long = 0;
intin(x, 1);

A LONG

}
else if (av->a_type==A FLOAT)

x->margs[0].a_type = x->mouttype = A _FLQOAT;
x->m out = floatout(x);

x->margs[0].a_w. w float = O;

floatin(x, 1);

}

else // if no argunment, set to a defualt

X->mouttype = A LONG
intin(x,1);

X->mout = intout(x);
SETLONG( x->m args + 1, OL);
SETLONG( x- >m args, OL);

return (x);

Figure 4. Sour ce code for the minimum object

March 8, 1999 17

10:00 PM



Max External Turorial (v. 2.2) Fujinaga

More Atoms and list

Max uses Atoms when passing messages between objects. If your object is going to
be able to send alist out of its outlet, it will have to use alist of Atoms. Likewise, if
you wish to receive lists, or more than 7 typed data in arguments from your object’s
box in the Max patcher, you will again have to deal with Atoms. Remember, Atoms
are ssimply a struct that have afield of type union that allows them to contain
different types of data.

It is now necessary to examine the structure of a message in Max. Consider the
following message box:

[play 100 200 2.5 =top |

addness(max_pl ay,
play to the “play”

addness(max_pl ay,

addness(at ons_pl ay,
message”

This message box contains 5 items, the symbol “play”, the long integers 100 and
200, the float 2.5, and finally the symbol “stop”. If this message is sent to your
object, your object will actually receive the message “ play”, followed by alist of 4
atoms containing 100, 200, 2.5 and “stop”. In other words, “play” is the message and
the remaining items are its arguments. One way to make your object understand this
message is to use addmess( ) inits main function.

“play”, A LONG A LONG A FLOAT, A SYM 0): /1 bind nethod nmax-

nmessage”

or with optional arguments, so that if some of the arguments are not specified by the
user, the object will set them to a default values:

“play”, A DEFLONG A DEFLONG, A DEFFLOAT, A DEFSYM 0);

But this approach requires that you always have two longs, afloat and a symbol in
the right order. Y ou are also limited to atotal of seven arguments using this
declaration method.

There is another way for your object to receive messages and their arguments. When
you declare amethod to receive its arguments with A_GIMME, the arguments will
be passed to your object in an argc, argv list. More about this argc, argv stuff later.

In order to tell Max to give you all of the arguments in a message, you bind your
method to the message in your main function with the Max function addmess. For
example, to bind the method atoms_play with the above message you would write in
your main function:

“play”, A G@MVE, 0); // bind nethod “atons_play” to the “play”

This call binds the method atoms_play to the message “play”. Whenever the object
receives the message “play”, Max will call the method atoms_play and passit the
message and alist of arguments.

A_GIMME tells Max to pass the message and its arguments without typechecking
them. Y ou are now responsible for typechecking them yourself.

Y ou now need to write a method that will be able to receive this message and its
arguments. The method atoms_play would be declared as:

void *atons_pl ay( Exanpl e *a, Synbol *ness, int argc, Atom *argv)

March 8, 1999
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In this function declaration, ais a pointer to your object, messis pointer to the
message that called this method (in this example the, “play” message). The integer
argc is the number of arguments contained in the atom list and argv is a pointer to an
array of atoms containing the actual arguments. Up to 65,536 arguments can be
received by a method.

If your object receives the message “play 100 200 2.5 stop”, Max will call your play
function. Your atoms_play function will receive a pointer to the symbol “play” in
mess, the integer 4 in argce, and finally a pointer to alist of atoms containing the
values 100 200 2.5 “stop”. The code in Figure 5 shows you how to typecheck and
access the datain the atom list.

#defi ne MAX_ARGS 20

typedef struct exanple /1 data structure for this object

hj ect a_ob;

Atom a_list[ MAX_ARGS]; // array of Atons: |ist

int a_size;

} Exanpl €;

void *atons_pl ay(Exanple *a,int argc, Atom *argv)

int i;

a->a_size = argc;
if (a->a_size > MAX_ARGS)
a->a_si ze = MAX_ARGS;

for(i =0; i < a->a_size; i++)
switch(argv[i].a_type) /1 type check each argument
case A LONG
SETLONG(a->a_list + i, argv[i].a_w w_|long);
Eost (k“argument %dis along: %d’, (long) i,argv[i].a_w w_|ong);
reak;
case A FLOAT:
SETFLOAT(a->a_list + i, argv[i].a w w float);
post (“argument %d is a float: %", (long) I, argv[i].a w w float);
br eak;
case A SYM

/1 nunber of Atonms in the list

SETSYM a->a_list + i, argv[i].a w w.syn);
post(“argunent %d is a synbol: %", (long) i,

argv[i].a_w w_sym >s_nane);
br eak;

March 8, 1999

Figure5. Typechecking an argc, argv list of atoms

This example receives alist of arguments from Max whenever the object receives the
“play” message. It then checks the type of each Atominthe argv list and storesit
into an internal array of Atoms. Finaly, it reports to the Max window the type and
value of the argument.

When working an Atom, you must be able to correctly accessits variousfields. In
Figure 5, we examine the a_typefield of an Atom to determine the type of data
contained in the union. As mentioned above a_type will be either A_LONG,
A_FLOAT, or A_SYM. These constants are declared in the Max #include file
“ext_mess.h”.

Notice that we use the struct notation argv[i].a_typeto accessthe a _typefield. Itis
also possible to use the pointer argv to accessthe field, i.e.,
(argv + i)->a type. Youmay choose whatever style suits you best.

In the above example, if the Atom containsalong (i.e., a type==A_LONG), we
want to store the argument into our internal Atom list, a list asalong. Likewise, if
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(a_type==A_FLOAT) wewould store it asafloat, and if (a_type==A_SYM) we
would store the argument as a symbol. Max provides several macros for storing an
item into an atom. These are:

SETLONG( At om *a, |ong nunber);

SETFLOAT(Atom *a, float nunber);
SETSYM At om *a, Synbol *s);

Here are the cuurent macro definitions as they appear in Max #includefile

“ext_mess.h”.
#defi ne SETSYM ap, x) ((ap)->a_type = A SYM (ap)->a_w. w.sym= (X))
#defi ne SETLONG ap, X) ((ap)->a_type = A LONG (ap)->a_w. w long = (x))
X))

#define SETFLOAT(ap, x)((ap)->a_type = A FLOAT, (ap)->a_w. w float = (x)

These macros accomplish two things. First the macro setsthe a_typefield of the
Atom to the correct type. This means that SETLONG will set the a_typefield of the
Atomto A_LONG, SETFLOAT setsit to A_FLOAT, and SETSYM setsit to
A_SYM. The macro then puts the long, float, or the pointer to the symbol into the
union a_w. Remember that a pointer to the symbol is stored in the union, and not the
actual symbol.

In the above example we used the following line of code to call SETLONG:
SETLONG(a->a_list + i, argv[i].a w w_|long);

Inthiscall, aisapointer to our Object. We use it to access the array of Atoms called
a list that isin our object’s data structure. Since SETLONG requires a pointer to an
Atom, we must give it a pointer to thei th Atom in the array. Wheni == 0, a>a list
+ iisapointer to thefirst Atominthearray a list. Likewisg, if i == 5, a>a list +
i isapointer to the 6th Atom in the array.

Notice how we access the long field of the union a_w in the argv Atom list. We write
argv[i] to accessthei th Atominthe argv list. argv[i].a w accesses the union a_w
field of the struct atom. Finally, argv[i].a w.w_long accesses the long value stored in
the union a_w. Wefirst access the atom, then the union, and finally the data.

Another way of putting along value into an Atomiis:

Using this method you are responsible for setting the a_type field yourself.

You can use SETFLOAT the same way as SETLONG. SETFLOAT will set the
a typefieldto A_FLOAT, and place the float valuein the float field of the union
a w(i.e,a ww_float). To access afloat field of an Atom in the argv list in the
above example, we write:

argv[i].a_wwfloat Or (argv + i)->a_w. w_ float

Likewise, to access thisvauein our interna array of Atomswe write:

a->a_list[i].a_wwfloat Or (a->a_list + i)->a w w float

When you want to store a symbol into an Atom, or access a symbol already in an
Atom, you must remember that a pointer to the symbol is stored in the Symbol field
of theunion a_w. Thefield in the union a_w is defined as Symbol *w_sym.
Therefore, in order to store a symbol into an Atom you store the pointer to the
symbol and not the symbol itself. Likewise, when you access a symbol, you need to
access what the pointer in the Symbol field pointsto. In other words, to get at a
symbol, there is yet another stage of indirection.
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In the above example, we use SETSY M to set the pointer to the symbol contained in
the argv list into our internal Atom list a list. Therefore, SETSY M wants a pointer to
the symbol as its second argument.

SETSYM a->a_list + i, argv[i].a_w w_sym;

Notice how we post the actual symbol to the Max window. We use the following
post function:

post(“argunent %d is a synbol: %", (long) i, argv[i].a_w w_sym >s_nane);

Note that in order to access our actual symbol, we must access what the symbol
pointer points to:

argv[i].a_w. w_sym >s_nane

In the Max #include file “ext_mess.h” asymbol is defined as the following struct:

struct synbol

char *s_nane; /* nanme */
struct object *s_thing; /* possible binding to an object */
} Synbol;

Therefore, in order to access a symbol in an Atom, first access the Atom, then the
union a w, thenthew_sym field and finally the s name field of the Symboal, i.e.,
argv[i].a w.w_sym->s name.

Now that you have alist of Atomsin your object you can send it to an outlet. To do
this you need to create alist outlet using the Max function:

Qutlet *listout (void *owner)
In our example we would create the list outlet in the object’ s creation function
example_new.

a->a_list_outlet = listout(Exanple *x);

To send theinternal list a_list out this outlet, one would use the Max function:

void *outlet_list(Qutlet *x, Symbol *msg, int argc, Atom *argv);

We would call this function with the following arguments:

outlet_list(a->a_list_outlet, “list”, a->a_size, & a->a_list));

where a->a_list_outlet is a pointer to the outlet we created with listout, “list” isthe
message to be sent, a>a_size is the number of Atomsin the internal Atom list, and
& (a>a list) isapointer to thefirst Atomin thislist.
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The atoms object:

Notice the addmess functions:

addness(atons_list,"play", A d MV 0Q); // bind method "atons_list" to "play" nessage
addness(atons_list,"list",AdMVEOQ); // bind method "atons_list" to "list" message

Both of these lines of code cause the function at ons_| i st to be called when the
object receives either the “play” message of the “list” message. Also naotice that we
requested that Max send to our object the arguments of the message as alist of
atoms. This was accomplished by using A_GIMME.

Thel i st Method

This method receives alist of atoms from Max contain the items of the list sent to
your object. The number of items (or atoms) in thelist isin argc. The actual atoms
are stored in argv. Actually these are pointers to atoms. We then check each atom for
its type before we put it in our list. The list method then sends the list of atoms out its
outletusingout | et _|i st.Noticeweuse&(a->a_list) topointtoourlist of
Atoms.

Thebang Method

When our object receives the bang message, it ssmply sends the current contents of
itslist out itsoutlet usingtheout | et _| i st function.

Thepost Method (Zicarelli 1996, 71)

When the object receives the “bang” message, it posts the contents of its Atom list to
the Max window using the function post at om (Zicarelli 1996, 72). Hereis how
to post alist of atoms:

[post | [play =. =.

- ||:-'I.al=| track—1 track-2
|
Eat-:-rnﬁtuff |
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This example uses the Clock object (Zicarelli 1996, 60-3), which allows scheduling
in Max. The routines associated wuth the Clock objects alows events to happen in
the future. Thisis accomplished by assigning a functin to be executed when the clock
goes off and indicate when the clock isto go off. More specifically:

1. Usecl ock_new() to create a Clock object and assign the function to be
executed when it goes off.

2. Usecl ock_set () orcl ock _del ay() toschedulethe execution of the
clock function at absolute time or relative time, respectively. Zicarelli
recommendsusing cl ock_del ay rather thancl ock_set (Zicarelli 1996,
61).

3. Whenthe Clock is no longer needed, it should be removed withf r eeobj ect
function.

/* This code resource defines the object "nmynetro" which is simlar to the standard
"metro" Max object. The metro object has 2 inlets and 2 outlets.

"bang" inleft inlet starts nmetronone
"stop" inleft inlet stops netronone
integer inright inlet sets tenmpo in ns

| eft output sends bangs at each nmetronone interval
right outlet outputs current tinme

The object al so posts messages to the Max wi ndow indicating the current state of
nymet r o.
*/

#i ncl ude "ext.h" /1 Required for all Max external objects
#define ResourcelD 4999 /* resource |D# for assistance strings */

#def i ne DEFAULT_TEMPO 1000
#define M N_TEMPO 40

typedef struct metro /* data structure for this object */
hj ect m_ob; /* must always be the first field; used by Max */
voi d *m cl ock; /* pointer to clock object */
| ong minterval; /* tenpo in mlliseconds */
voi d *m bang_outl et; /* pointers to bang outlet */
voi d *mtinme_outlet; /* pointers to tine outlet */
} Metro;

void *netro_new(l ong val ue);

void *metro_inl(Metro *m |ong val ue);

void *netro_bang(Metro *m;

void *netro_assist(Metro *m Object *b, long nsg, long arg, char *s);
void *metro_free(Metro *m;

void *netro_stop(Metro *m;

void *clock_function(Metro *m;

voi d *cl ass; /! Required. dobal pointing to this class

voi d mai n(voi d)

{

/* set up our class: create a class definition */
setup(&cl ass, (nethod)netro_new, (nethod)netro_free, (short) sizeof(Metro), OL,
A DEFLONG, 0);

/* bind nethod "metro_bang" to the "bang" message */
addbang( (et hod) met r o_bang) ;
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/* bind nethod "metro_inl" to int's received in the right inlet */
addi nx((method)metro_ini, 1);

/* bind nethod "metro_stop" to the "stop" message" */
addness((net hod)netro_stop, "stop", 0);

/* bind nethod "metro_assist" to the assistance nessage" */
addness((nethod)netro_assi st, "assist", A CANT, 0);

/* copy the assistance nmessages resource into the Max tenp file */
rescopy(' STR#' , Resourcel D);

/* add class to the New object list */
finder_addcl ass("All Objects","nmynetro");
}

/**********************************************************************************

metro_new( | ong val ue)

i nput s: value - the integer fromthe typed in argunent in the object box
description: creates a new instance of this class netro.
returns: pointer to new i nstance

*************************************************************************************/

voi d *netro_new(l ong val ue)
Metro *m

m= (Metro *)newobject(class); // create the new instance and return a pointer to it

if (value > M N_TEMPO /1 initialize the subtraction val ue
m >minterval = val ue; /1 save tenpo arguenent from box
post ("nynmetro tenmpo set to %d", value);

el se

{

m >m i nterval = DEFAULT_TEMPO /'l set to default tenpo
post("nynmetro set to default tenpo of %d nms", DEFAULT_TEMPO);

m >m cl ock = clock_new(m (nethod)clock_function); [// create the metrononme cl ock
intin(m 1); /

m>mtimnme_outl et intout(m; /
m >m_bang_out | et bangout (m; /

| create the right inlet
/| create right outlet for tine
/| create left outlet for ticks

return(m;
}
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metro_inl(Metro *m |ong val ue)

i nput s: m -- pointer to our object
value -- value received in the inlet
description: stores the new netronone tenpo val ue

LR R R R E R EERE R EEE R R R EEE R R R R R R R R R LRy

void *netro_inl(Metro *m |ong val ue)

m>m.interval = val ue; /'l store the new metronone interval
post ("metronome tenpo changed to % d", val ue);

/*************************************************************************************

voi d *netro_bang(Metro *m

i nput s: m-- pointer to our object
description: nethod called when bang is received: it starts the netronone

LR R R R E R ERE R EEE R R R R R R R R R R R LRy

voi d *netro_bang(Metro *m

{
long tinme;
time = gettime(); /1 get current time
cl ock_set(m>mcl ock, tine); /1 set clock to go off now
post("clock started at %d", tine);
}

AR R R RS EEEEEEEEEEELEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE]

void *netro_stop(Metro *m
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i nput s: m-- pointer to our object
description: nethod called when nyMetro receives "stop" nessage. Stops the netronone

LR R EEE R R RS EE R R E R R R R R R R R R R R R LRy

void *netro_stop(Metro *m

{
long tine;
time = gettime(); /Il get current tinme
cl ock_unset (m >m cl ock) ; /1 renove the clock routine fromthe schedul er
outlet_int(m>mtinme_outlet, tine);
post (" metronome stopped at %d", tine);
}

/*************************************************************************************
voi d clock_function(Metro *n

i nputs: m-- pointer to our object ]

description: nmethod called when clock goes off: it outputs a bang to be sent to the
outlet and resets the clock to go off after the next interval.

*************************************************************************************/

voi d *clock_function(Metro *m

{
long time;
time = gettine(); /1 get current tine
cl ock_del ay(m>mcl ock, m>m.interval); /'l schedul e anot her netronone click
out | et _bang(m >m bang_outlet); /1 send out a bang
outlet_int(m>mtinme_outlet, tinme); /1 send current time to right outlet
post ("clock_function %d", tine);

}

/*************************************************************************************

metro_free(Metro *n

i nputs: m-- pointer to our object ] ]

description: nethod called when Metro objects is destroyed. It is used to free nenory
al | ocated to the clock.

*************************************************************************************/

void *netro_free(Metro *m

cl ock_unset (m >m cl ock) ; /1 renove the clock routine fromthe schedul er
cl ock_free(m >m cl ock); /Il free the clock nenory

}
void *netro_assist(Metro *m Ooject *b, long nsg, long arg, char *s)

/] copy the appropriate message to the destination string
assi st_string(Resourcel D, nmsg, arg, 1L, 4L, s);
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